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COMMUNICATIONS
Operation Manual

PROPRIETARY RIGHTS NOTICE

This manual contains valuable information and material developed by Arizona
Instrument LLC for use with the Computrac® VAPOR PRO®, VAPOR PRO® Rx,
VAPOR PRO® Fx, and the VAPOR PRO® COMMUNICATIONS Package. No part of
this manual or the accompanying software can be reproduced or transmitted in any form
or by any means, electronic, mechanical, or otherwise. This includes photocopying and
recording or in connection with any information storage or retrieval system without the
express written permission of Arizona Instrument LLC.

ALL RIGHTS RESERVED

© Copyright 2003-2010, Arizona Instrument LLC

Windows®, Office® and Excel®are registered trademarks of Microsoft Corporation in the
United States and other countries.
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1. Welcome to VAPOR PRO® COMMUNICATIONS Package

The VAPOR PRO® COMMUNICATIONS software is a Windows® based program
designed to collect data from one or more VAPOR PRO®, VAPOR PRO® RX, or
VAPOR PRO® Fx instruments to a personal computer through the RS-232 interface
(COM port). The software can download data from any of a number of VAPOR PRO®
units to a personal computer for data analysis using Microsoft® Excel or for long-term
storage. The VAPOR PRO® COMMUNICATIONS software can also upload memory
start test parameters from the central PC to the VAPOR PRO®’s to ease and simplify
multi-unit programming.

Help is available on many functions within the communications program. Press the F1
key to activate the help files.

The VAPOR PRO® COMMUNICATIONS Package is used to:

o Download/Edit/Upload memory starts from one or more VAPOR PRO® instruments
e Download test and graph data from one or more VAPOR PRO® instruments
e Print test data, graphs, and memory starts.

Benefits of the VAPOR PRO® COMMUNICATIONS Package:

e Program, edit, download memory starts from your PC
» Easily manage and standardize test parameter sets to single or multiple units
» Maintain backup copies of memory starts on a PC or network.
e Customizable report formats
» Provides precisely the information you need
e Built-in desk-top tutorial
» Walks new users through configuration and setup
e Instrument model and serial number printed on reports
» Maintains data trails
e Enable pass/fail criteria
» Provides quick assessment of product against quality standards or SOP’s
e Microsoft Excel® format
» Data is stored in spreadsheet format for easy reporting, management, and
analysis.

The VAPOR PRO® COMMUNICATIONS Package (AZI P/N: Y990-0196) includes
the following:

710-0049 VAPOR PRO® COMMUNICATIONS software (on CD)
6000 1044 RS232 Null Modem Cable
700-0098 VAPOR PRO® COMMUNICATIONS user’s manual (on CD)
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There is a set of five tutorials that explain the set-up, configuration and usage of the
VAPOR PRO® COMMUNICATIONS software. These tutorials are available on the
AZI website at www.azic.com, as well as in the Arizona Instrument directory on your
Start Menu if you have installed the software.

2. Instrument setup & Configuration

Connecting a VAPOR PRO® series instrument to a PC to utilize VAPOR PRO®
COMMUNICATIONS is a simple process that involves connecting the included RS232
Null Modem cable (AZI P/N: 6000 1044) between the serial port on the PC and the
computer communication port on the VAPOR PRO®. If there is not an available serial
port on the PC, a USB-t0-RS232 adapter (AZI #990-0238) can be used to connect to an
available USB port on the PC instead. In the VAPOR PRO® menu, the external printer
output port must be set to RS-232 and the printer driver must be set to EPSON ESC/P2.

A step-by-step tutorial describing this process, Tutorial 1: Connecting the VAPOR
PRO®, is available on the AZI website at www.azic.com, as well as in the Arizona
Instrument directory on your Start Menu if you have installed the VAPOR PRO®
COMMUNICATIONS software.

To connect multiple VAPOR PRO®’s requires additional available serial ports on the
target PC or the utilization of a Serial to Ethernet adapter (AZI P/N: 990-0209 or 990-
0210) to connect the instruments to a network. For more information on using a network
to connect to the instruments, see Networking VAPOR PRO®'s on page 19.
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3. Installing the VAPOR PRO® COMMUNICATIONS Package

System Requirements

1. One or more VAPOR PRO® series instruments:
a. VAPOR PRO® or VAPOR PRO® Rx- firmware version 1.13.1 or higher, or
b. VAPOR PRO® Fx — firmware version 1.15.1 or higher
2. Windows® XP or Windows® 7 (32 or 64-bit) (VAPOR PRO®
COMMUNICATIONS has been tested on the English-US versions of Windows)
Internet Explorer version 5.01 or higher
4. One unused RS-232 serial port, or for network installations, an Ethernet port and
a Serial to Ethernet adapter. See Parts and Accessories on page 18 for more
information.
a. Ifan RS-232 serial port is not available, a USB-to-RS232 adapter
(AZI #990-0238) can be used to connect to a USB port instead.
5. Microsoft Excel® XP (2002) to Excel® 2010 is required to view and analyze
stored data.

w

] Windows® XP Windows® 7
Processor 1.0 GHz or faster l'oo?élz.tfii Iisétj)r Srzock:)tletss%? R
Memory 196 Mb (256 Mb recommended) % gg Eﬁm Egig:i :z::gm;
Hord Dis 200 Wi 630 Mo (64-bit syt

! Hard disk space requirements include installing the Microsoft .NET Framework version 2.0

Administrator and Power User Privileges

The VAPOR PRO® COMMUNICATIONS Package can be installed for the current user
or for all users. Local administrator privileges on the target PC are required to install for
all users.

Users of the software must be at least Power Users on the target PC in order to use the
software successfully. This setting can be changed by an administrator using the user
accounts selection in the PC Control Panel.

Note: The VAPOR PRO® COMMUNICATIONS Package requires the Microsoft .NET
Framework version 2.0 or higher. If your computer does not have the .NET Framework
installed, the VAPOR PRO® COMMUNICATIONS Package setup will install it. If you
require a non-English version of the .NET Framework, you must download it from
Microsoft’s web site or install it through Windows Update. Installation of the NET
Framework requires Administrator privileges on the target PC. It is recommended that
you contact your IT department or computer support personnel before installing this
software.
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Installation

1. Insert the VAPOR PRO® COMMUNICATIONS Package install CD into the CD
or DVD drive on your computer.

2. The setup program should start automatically.
> If the setup program does not automatically start, click the Start button.

> Click Run.
> Type D:\Setup.exe and hit Enter. (where D: is the letter of your CD or
DVD drive.)

Follow the instructions in the setup wizard to complete the installation.

I To Uninstall the VAPOR PRO® COMMUNICATIONS program

1. On Windows® XP, go to Add/Remove Programs in the Control Panel.
On Windows® 7, go to Programs and Features in the Control Panel.

2. Find and select "VAPOR PRO® COMMUNICATIONS" from the list of installed
programs.

3. Click the [Remove] or [Uninstall] button to uninstall.

Note: This will only uninstall the VAPOR PRO® COMMUNICATIONS Package. It
will not uninstall the Microsoft .NET Framework. The .NET Framework is a separate
entry in Add/Remove Programs.

4, Starting the VAPOR PRO® COMMUNICATIONS program

To start VAPOR PRO® COMMUNICATIONS Package:

Click the VAPOR PRO® COMMUNICATIONS icon on the Windows desktop

or

Go to the Start menu and click All Programs = Arizona Instrument > VAPOR PRO®
COMMUNICATIONS.

Tutorial 2: Starting VAPOR PRO® COMMUNICATIONS is available on the AZI
website at www.azic.com, as well as in the Arizona Instrument directory on your Start
Menu if you have installed the VAPOR PRO® COMMUNICATIONS software. This
tutorial provides visual step-by-step instructions for starting the software.
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5 Main Form

Below is the Main Screen of the VAPOR PRO® COMMUNICATIONS software.

Ianmu nications Ea.cka.ge M

File Tools ‘Window Help

Connected Fapnr Pros

Coarn Part | Instrument Location | Mermom Start | Laszt Result | Serial Murnber | Firrmiware Hevl
.S'EDM‘I Test Bench 1522 1.131

Yapor Pro dizcoverny process is complete.

Menus

The menu options available from the Main Screen are listed and explained below:

File
1. Import
2. Memory Starts - Imports previously exported memory starts from a text
file.
3. Memory Start Definitions - Imports a new/updated memory start
definitions file.
4. Stored Test Definitions - Imports a new/updated stored test definitions
file.
5. Export

6. Memory Starts - Exports selected memory starts to a text file.
7. Stored Data - Exports selected test data to a comma delimited text file.
8. EXxit - Closes all COM ports and exits the program.
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Tools
1. Scan for VAPOR PRO®s - Immediately scans all unused COM ports for
VAPOR PRO® instruments.
2. Manage Named Sets - Opens the Manage Named Sets window.
3. Options - Opens the VP-Comm options window.

Window
1. Cascade - Organizes the open windows in a cascading order.
2. Tile Horizontally - Organizes the open windows tiled horizontally.
3. Tile Vertically - Organizes the open windows tiled vertically

Help
1. Contents - Opens the online help file to the Contents page.
2. Index - Opens the online help file to the Index page.
3. Search - Opens the online help file to the Search page.
4. About VP-Comm - Displays the About dialog with program version information.

6. Edit Memory Starts

Tutorial 3: Editing Memory Starts is available on the AZI website at www.azic.com, as
well as in the Arizona Instrument directory on your Start Menu if you have installed the
VAPOR PRO® COMMUNICATIONS software. This tutorial provides visual step-by-
step instructions for downloading, editing, and uploading memory starts between the
instrument(s) and the PC.

o Vapor Pro Communications Package M
LEiIe Tools  Window Help
Connected Vapor Pros
Com Port | Inztrument Location | Memony Start | Last Result | Senial Mumber | Firmware Fey |
IS'ED.‘“ oo St 1131
55 Memory Starts - Test Bench H
Instrument memory starts Saved memomny starts
000: RESERVED A VB Pl
001: RESERVED ME Paly 2
002 Sample Test 1 ME Paly 3
003 Sample Test 2 %Sample Test1
004: Poly 1 %Sample Test 2 b
005 Paoly 2 A

Q0B Paly 3
oov:
iong:
0o9:
oo
011:

()

Right-click. memory startz for a command menu,

Dirag and drop memory starts to copy them between the Close |

instrument and disk.
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Features of this window

Drag and Drop

Both the Instrument memory starts list and the Saved memory starts list are drag-and-
drop enabled. Memory starts can be saved from the VAPOR PRO® to disk by selecting
and dragging memory starts from the Instrument list on the left to the Saved list on the
right. Likewise, memory starts can be copied from the saved list to the VAPOR PRO®
the same way.

The memory starts on the VAPOR PRO® instrument can be re-ordered also. Select the
memory starts you want to move and drag them to their new position. A black line will
appear and follow your mouse showing you where they will be dropped.

Context Menus

The Instrument memory starts list has a context (right-click) menu with the following
commands:

1. Edit (this is also the default action when a memory start is double-clicked)
Opens the Edit Memory Start Parameters window to edit the selected memory start.

2. Load Named Set
Clears the current memory starts and loads the memory starts from a named memory
start set into this VAPOR PRO®.

3. Print Selected
Prints only the selected memory starts and their parameters.

4. Print All
Prints all memory starts and their parameters

5. Send to VAPOR PRO®
Uploads the selected memory starts back to the VAPOR PRO®.

6. Send All Changed
Uploads all changed (shown in Blue text) memory starts to the VAPOR PRO®.

7. Clear Parameters
Clears the parameters of the selected memory starts
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The Saved memory starts list has a context (right-click) menu with the following
commands:

1. Edit Name
Allows you to change the name of a saved memory start to prevent a naming conflict.

2. Delete
Deletes the selected saved memory starts from disk.

7. Manage Named Memory Start Set

Named Memory Start Sets are a quick and easy way to standardize the memory starts
across multiple VAPOR PRO® instruments.

Tutorial 5: Using Named Memory Start Sets is available on the AZI website at
www.azic.com, as well as in the Arizona Instrument directory on your Start Menu if you
have installed the VAPOR PRO® COMMUNICATIONS software. This tutorial
provides visual step-by-step instructions for creating and editing Memory Start Sets and
programming an instrument with a Memory Start Set.

&» Vapor Pro Communications Package uw

LEiIe Tools  Window Help

Connected Vapor Pro

ComPart___|| 55 Manage Named Memory Start Sets EJW Serial Numnber | Fitmware Fiev |
'Sl COM1 Mamed memony start sets 1522 1131
Paly Tests
Mew |
Edit |
Delate |
W apar Pro dizca
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Named memory start sets list
Lists the named memory start sets currently saved in the memory starts folder.

New button
Creates a new named memory start set. You will be prompted for a name for the set then
taken to the Edit Memory Start Set window.

Edit button
Allows you to add and remove memory starts from the selected named set via the Edit
Memory Start Set window.

Delete button
Deletes the selected named memory start set from disk.

Close button
Closes the window.

8. Edit Memory Start Set

F =y

52 Mamed Set - Poly Tests
Mamed zet memary starks Saved memary starts
VB Paly 1
Foly Test | ¥
| oly Tests Renarne VB Poly 2
VB Paly 2
VB Poly 1 ﬁ;{ !
% Sample Test 1
m Poly 2 % Sample Test 2
VB Paly 2

Right-click memary starts for a command menu,

Save and

Drag memary starks from the Saved memory starks lizt and e

drop them on the Mamed Set to build your zet.
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editmemorystartset
editmemorystartset
editmemorystartset
editmemorystartset
editmemorystartset

Named set memory starts textbox
Here is the name of your named memory start set. This textbox cannot be typed into
directly. Use the Rename to rename your set.

Rename button
Opens a window for you to edit the name of your memory start set.

Named set memory starts list
The memory starts in your set.

Saved memory starts list
The memory starts saved on disk.

Save and Close button
Saves the set and closes this window

Features of this window

Drag and Drop

Both the Named set memory starts list and the Saved memory starts list are drag-and-
drop enabled. Memory starts can be added to the set by selecting memory starts in the
Saved memory starts list on the right and dragging them to the Named set memory starts
list on the left.

The memory starts in the Named set memory starts list can be re-ordered also. Select the
memory starts you want to move and drag them to their new position. A black line will
appear and follow your mouse showing you where they will be dropped.

Context Menu

The Named set memory starts list has a context (right-click) menu with the following
command:

Remove
Removes the selected memory starts from the set.
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9. Select Stored Tests

Tutorial 4: Downloading and Viewing Test Data is available on the AZI website at
www.azic.com, as well as in the Arizona Instrument directory on your Start Menu if you
have installed the VAPOR PRO® COMMUNICATIONS software. This tutorial
provides visual step-by-step instructions for downloading and viewing test data from the
instrument(s) on the PC.

The Select Stored Tests window (below) narrows down a search for memory starts before
displaying the results in the List Tests window. This is currently only used when
exporting saved tests.

u5 Select Stored Tests to Export E]@

Al dates Instument:
" Date Range | =] w| Test Bench

o | [
Mermnory start name: |[E'n-IIJ Memory start] ﬂ
Lfs i |[any Lat nurber) j
Product ID: |[an_l.J Froduct (D] ﬂ

OF. LCancel

All Dates
All test dates will be included in the query.

Date Range
Only dates that fall within the Start date and End dates (inclusive) will be included in the

query.

Start date
The earliest test date to include in the query results.

End date
The latest test date to include in the query results.
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Memory start name
Allows you to search for tests run on any memory start or just one specific memory start.

Lot number
Allows searching for tests from a specific lot number.

Product ID
Allows searching for tests with a specific product ID.

Instrument list
Allows searching for tests run on specific VAPOR PRO® instruments.

OK button
Accepts the search criteria, closes this window, and displays the search results.

Cancel button
Closes this window without running the search.

10. VAPOR PRO® COMMUNICATIONS Options

The Options dialog box is displayed below, followed by explanations of the fields.

F‘I.I'P-E omm Cptions E]@

|ieu:ts'\‘»-’F'Eu:ummWF'Eu:umm'\bin'xH eleasehStored Datah

[rata faolder:

Memory start folder |E:'\D|:n:uments and Settingzhddoede AZ1C WMy Docu

E ucel template folder: |E:'\D|:n:uments and Settingzhddoede AZ1C WMy Docu

Diefault graph template: |E:'\D|:n:uments and Settingzhddoede AZ1C WMy Docu

EEEEE

Path to Excel exe |

M aximum results in test history ist: m

| k. | Cancel

Arizona Instrument Customer Service 800-528-7411 or 602-470-1414 Page 16 of 29




Data folder
This is the folder where the saved test database is stored. It is also the default save
location for exported tests. It can be a local or network folder.

Memory start folder
This is the folder where memory starts and named memory start sets are stored. It can be
a local or network folder.

Excel template folder
This is where the Excel template files that the VAPOR PRO® COMMUNICATIONS
Package uses. It can be a local or network folder.

Default graph template

This is the default template used when you view saved tests from the Connected
VAPOR PRO®’s context menu. The template DefaultSingleTestGraph.xlt is included
with the VAPOR PRO® COMMUNICATIONS Package. It shows all end of test data
and both the Total Moisture graph and the Rate graph.

Path to Excel.exe

This field is normally not necessary. However with some installations of Microsoft
Office, Windows cannot find Excel on it's own. If VAPOR PRO®
COMMUNICATIONS gives you an error saying MS Excel cannot be found, browse to
Excel.exe manually here. It is usually found:

Office XP (2002) | C:\Program Files\Microsoft Office\Officel0

Office 2003 C:\Program Files\Microsoft Office\Officell

Office 2007 C:\Program Files\Microsoft Office\Office12 (32-bit Windows®)
Office 2007 C:\Program Files (x86)\Microsoft Office\Office12 (64-bit Windows®)
Office 2010 C:\Program Files\Microsoft Office\Office14 (32-bit Windows®)
Office 2010 C:\Program Files (x86)\Microsoft Office\Office14 (64-bit Windows®)

Maximum results in test history list
This is the maximum number of past tests that will be displayed in the View Test Results
menu in the context menu for the Connected VAPOR PRO®’s window.

OK button
Saves the changes to the options and closes the window.

Cancel button
Closes the options window without saving changes.
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11. Parts and Accessories

VAPOR PRO® | 710-0049  VAPOR PRO® Communications

Y990-0196 Communications software
Package 6000 1044 RS232 Cable

4-Port Serial to
990-0209 Ethernet
Adapter

1-Port Serial to

990-0210 Ethernet
Adapter
990-0238 USB-t0-RS232

Adapter

Arizona Instrument Customer Service 800-528-7411 or 602-470-1414 Page 18 of 29




12. Networking VAPOR PRO®’s

To connect VAPOR PRO®s to a network instead of directly to a PC, a Serial to
Ethernet Adapter (AZI P/N: 990-0209 or 990-0210) is required.

1) Connect an RS-232 Null Modem cable (AZI P/N: 6000 1044) from the VAPOR
PRO®’s PC connection to the Serial to Ethernet Adapter.
2) The following steps are to be carried out by your local IT person.

a. Connect the Serial to Ethernet Adapter to your local area network.

b. Install the drivers for the Serial to Ethernet Adapter according to the
instructions provided with the adapter (local computer Administrator
rights are required.)

c. Runthe VLINX ESP Manager, click Start = All Programs - B&B
Electronics > VLINX - ESP Servers - VLINX ESP Manager.

d. Set each port on the Serial to Ethernet Adapter as shown below. Use your
own unigue identifying name for the Server name, and your static IP
address, Netmask, and Gateway.

e. Install the virtual com ports according to the instructions provided with the
Serial to Ethernet adapter.

3) Start the VAPOR PRO® COMMUNICATIONS program.

Server Properties @

BB Electronics

VLN ESP
Server name:; W Serial port: Iﬁ Delimiter HE= 1: IDD—
Serial number: I— Baudrate:  [gg0p - Delimiter HEX 2 IDD—
Pazaword: I— D ata/Stap bits: m Force tranzmit: |-|— #100ms [0-65535)
DHCP: Im Parity: Im Port status: I—
P address:  [192168.2236 Flow control m TCRAUDP ot [so00
Metmaszk: m Protocal: TCP - Serial part mode: Im

Gateway:  |192182.21 -
AC addhos |— Serial timeout: 0 [0-65535 zec) Connection at: l—_l

Version & Date: I— TCP alive tirmeout; Ini [0-255 min]  Masimum connection: m
Link status:  [T57Hal Duplen Connection mode: |5 epyer - Remate IF addiess:  |255 255 255 255

Hardware [D;

pdate | Cancel |

Serial to Ethernet Adapter Configuration
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13.

Troubleshooting

Possible Problems and Solutions

Symptom

Likely Cause

Solution

Database Errors

User is not a Power User on
the target PC

Have System Administrator/IT Dept modify
the current user to a Power User through the
Control Panel.

See page 7

Communication
Errors when using
Serial to Ethernet
adapters

Serial to Ethernet adaptors
do not have static IP
addresses

Use static IP addresses for the Serial to
Ethernet adapters, not DHCP.
See page 19

No Data displayed in
Excel

Excel Macro security set too
high

Set Excel Security to Medium.
See page 21

Memory Start Format
Error

Instrument contains new
firmware.

The format of memory
starts has changed from
version 1.13.1 (VAPOR
PRO® and VAPOR PRO®
RX models) and 1.15.1
(VAPOR PRO® FX model)
to versions 1.13.2/1.15.2.

Contact AZI Customer Service for an
updated Memory Start Definitions file.
See page 24

Run the Data Conversion Utility included
with the software to modify existing memory
starts to be compatible with firmware
versions 1.13.2/1.15.2. See APPENDIX A
— DATA CONVERSION UTILITY on page
26.

Format Error while
downloading stored
tests

Instrument contains new
firmware.

Contact AZI Customer Service for an
updated Stored Test Definition file.
See page 24
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Microsoft Excel® Macro Security

If no data is displayed in Microsoft Excel when you try to view instrument data, Excel's
macro security may be set to High. This prevents the template from working.

On Microsoft Office® 2003 or earlier: If this happens, open Excel, click the Tools menu,
then the Macro sub menu, and click Security...

B9 Microsoft Excel - Book1

21

22

Am

= | AutoCaorrect Options...
Customize. ..

Qptions. ..

Data Analysis...

@_] File Edit Wew Insert Format | Tools | Data Window Help Adobe FDF
e 3 O V| wein- ol e e -0 -|B I U
A - A éi Researdh... Alt+Click
A B | = | ‘@ Error Cheddng... | H | I | J | K | L

;_ Speech 3

3 Shared Workspace. ..

4 Share Workbook. ..

5

3 Track Changes 3

T Compare and Merge Workbooks. ..

g Protection 3

10 Online Collaboration 3

11 Goal Seek...

_ Scenarios

13 -

14 Formula Auditing 3

1; Macro 4 | Macros... Alt+F3

17 Add-Ins... @ | Record Mew Macro,..

18 Security...

19

20 #| visual Basic Editor Alt+F11
@ Microsoft Script Editor — Alt+Shift+F11

Set macro security to Medium or lower (Medium is recommended).
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| Trusted Publishers

macros,

¥ou open.

() Very High, Only macros installed in trusted locations will be allowed
to run. All other signed and unsigned macros are disabled.

() High. Only signed macros from trusted sources will be allowed to
run. Unsigned macros are automatically disabled.

() Medium. You can choose whether or not to run potentially unsafe
(") Low (not recommended). You are not protected from potentially

unsafe macros. Use this setting only if you have virus scanning
software installed, or you have checked the safety of all documents

OK

l [ Cancel
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On Microsoft Office® 2007 or later: The Excel® template will not work if macro security
settings are set to “High” and a screen similar to the one below will be displayed.

¥ " - pat -

Home Insert Page Layout Formulas Data Review View Developer &3 e = B

I:IIE .j;. Times Mew Roman - 10 = A" A7 E[%] B = T ” ijﬁ‘ ﬁ _,T_‘E‘ o ;: % (?a l

3 :_P‘ Delete =
Paste F U~ e e A . = .
- - 4 B - - - % Formatting ~ as Table = Styles = Lleormat' 27 Filter~ Select~

EEE | $ - % » | %99 | Conditional Format  Cell Sort & Find &
Clipboard = Font ] Alignment ] Number ] Styles Cells Editing

«00 .0
y Security Warning  Macros have been disabled. Enable Content x

D4 —_ 5| v

A B E D E F G H I il Saumulaba L M N =
Template will not run with macro security set to "High"

1
2
3
: —1
5
6
7
8

—
=
1[]

23
4 4 » M| Data Out  Total Moisture Chart - Rate Chart ~#J [a] T | » [1]
Ready | 73 | ||§|E 100% (=) ()

Macro security settings can be changed in the Trust Center, unless your IT department
has changed the default settings to prevent any changes.

To update macro security settings:

1. On the Developer tab, in the Code group, click Macro Security.

Home Insert Page Layout Formulas Data Review View Developer
E B record Macro — S Mi [%F Properties (== 5 Map Froperties T Import OE
E == D e =
= @ Use Relative References = == o View Code = % Expansion Packs {8 Export

Visual Macros Add-Ins COM Insert Design Source o, Document
Basic A1 Macro Security Add-Ins - Mode & Run Dialog “4 Refresh Data Panel

Code Add-Ins Controls XML Modify

- ( 3 | v

In Office® 2007, if the Developer tab is not displayed, click the Microsoft
(Ba

Office® Button " , click Excel Options, and then in the Popular category,
under Top options for working with Excel, click Show Developer tab in the
Ribbon.
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2. Inthe Macro Settings category, under Macro Settings, click the option that you
want. “Disable all macros with notification” is recommended. Excel® will then
notify the user that a macro has been blocked, and provide the option to enable the
macro.

i r —
WL . w vvy a . el
T o

Trusted Publishers

Macro Settings

Trusted Locations i
() Disable a]l macros without notification
iustediiosuments @ Disable all macros with notification

Add-ins () Disable all macros except digitally signed macros

() Enable all macros (not recommended: potentially dangerous code can run)
ActiveX Settings

Macro Settings Developer Macro Settings

Protected View |:| Trust access to the VBA project object model

Message Bar
External Content
File Elock Settings

Privacy Options

[ ok || cancl

These changes will only affect Excel® and do not affect any other Microsoft
Office® program.

The Trust Center can also be accessed from the Excel Options dialog box. Click the

(Da
Microsoft Office® Button |, and then click Excel Options. In the Trust Center
category, click Trust Center Settings, and then click the Macro Settings category.
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Memory Start Definition file

Memory Start Definition file

The Memory Start Definition file contains information that the VAPOR PRO®
COMMUNICATIONS Package uses to interpret memory start data downloaded from
each model of VAPOR PRO®. Different models of VAPOR PRO®’s have different
memory start parameters. If a future version of the VAPOR PRO® instrument firmware
changes the format of the memory starts to add features to the instruments, an updated
Memory Start Definition file will be needed in order for the VAPOR PRO®
COMMUNICATIONS Package to download, edit, and upload memory starts. If you
receive a memory start format error from VAPOR PRO® COMMUNICATIONS,
contact Arizona Instrument Customer Service for an updated Memory Start Definition
file.

Stored Test Definition file

Stored Test Definition file

The Stored Test Definition file contains information that the VAPOR PRO®
COMMUNICATIONS Package uses to interpret stored tests downloaded from each
model of VAPOR PRO®. Different models of VAPOR PRO®s have different stored
test parameters. If a future version of the VAPOR PRO® instrument firmware changes
the format of the stored tests to add features to the instruments, an updated Stored Test
Definition file will be needed in order for the VAPOR PRO® COMMUNICATIONS
Package to download stored tests. If you receive a format error from VAPOR PRO®
COMMUNICATIONS while downloading stored tests, contact Arizona Instrument
Customer Service for an updated Stored Test Definition file.
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Support

You can consult http://www.azic.com 24-hours-a-day to find the latest product

information, product updates, and answers to common questions.

For technical support contact us directly, e-mail: support@azic.com

Arizona Instrument LLC
3375 N Delaware Street
Chandler, AZ 85225
(800) 528-7411
(602) 470-1414
Fax (480) 804-0656
http://www.azic.com
email:
azi@azic.com - General
intl@azic.com - International

support@azic.com - Customer Support
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15. APPENDIX A - DATA CONVERSION UTILITY

Available in VAPOR PRO® COMMUNICATIONS v1.0.1 and higher.

The format of the memory starts stored in the instrument has changed from version 1.13.1
(VAPOR PRO® and VAPOR PRO® RX models) and 1.15.1 (VAPOR PRO® FX
model) to versions 1.13.2/1.15.2. The Data Conversion Utility will make copies of
existing 1.13.1/1.15.1 memory starts and modify them to work with the 1.13.2/1.15.2
VAPOR PRO®'s. If you are transferring memory starts from a firmware version 1.13.1
or 1.15.1 instrument to a firmware version 1.13.2 or 1.15.2 instrument, and you receive a
memory start format error, run the Data Conversion Utility included with VAPOR
PRO® COMMUNICATIONS v1.0.1 to update your memory starts.

If the Data Conversion Utility is not listed in the AZI folder on the Start Menu, VAPOR
PRO® COMMUNICATIONS must be upgraded to version 1.0.1 with Data Conversion
Utility (or higher). Contact AZI at 800-528-7411 or 602-470-1414 for information.
Before installing the new version of VAPOR PRO® COMMUNICATIONS, any
previous versions of the software should be uninstalled using Add/Remove Programs in
the Windows Control Panel. Uninstalling previous versions of the software will not erase
any data stored on the PC by VAPOR PRO® COMMUNICATIONS.

To run the Data Conversion Utility, find the AZI folder on your Start Menu and select
Data Conversion Utility.

This opening screen will be displayed.

VP-Comm Data Conversion Utility

¥ Pro Commumications Data Conversion LRilit

The format of memory starts has changed from version
1.13.1 {WVapor Pro and Vapor Pro R models) and 1.15.1
[Vapor Pro FX model) to versions 1.13.2/1.15.2. This
Diata Conversion Utility will make copies of exdsting
1.13.1/1.15.1 memary starts and modify them to work
with the 1.13.2/1.15.2 Vapor Pros. The new memony
starts will have {2) appended onto the name. it will also
make copies of your memory start named sets and update
the memorny starts. The copies will have a (2) appended
onto the name of the named set, not the individual
MEmony starts.|

| Continue
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Press “Continue” to proceed to the main window of the Data Conversion Utility, below.

Vapor Pro Communications - Data Converter Utility [Z||E| '
ﬁﬁrnwse @Cunuert |

Wapor Pro Communications configuration file;

Zlick Browse to manually find Vapor Pro Communications

Activity Log;

Searching for Vapor Pro Communications in the registry.

Searching for Vapor Pro Communications in the default install folder.
Could not find Yapor Pro Communications.

Searching Program Files for Vapor Pro Communications.

Could not find Vapor Pro Communications.

Click “Browse” to search your computer for memory starts and memory start sets that
need to be updated.

Then click “Convert” to modify the memory starts to be compatible with the updated
firmware.

The new memory starts will have '(2)' appended onto the name. The utility will also make
copies of your memory start named sets and update the memory starts. The copies of the
memory start sets will have a (2) appended onto the name of the named set, not the
individual memory starts.

Now the updated memory starts and memory start sets can be uploaded to the desired
instrument using the Send to VVapor Pro® option, as explained in Edit Memory Starts
on page 10. Be sure to upload the new memory starts, which have ‘(2)’ appended to the
name. The new, updated memory starts can also be renamed using the Edit Name
command, also available from the Edit Memory Starts window. See page 12 for more
information on renaming memory starts.
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16. APPENDIX B - SOFTWARE VERSION HISTORY

V1.0.3:
e Verified compatibility with Windows® 7.
e Changed VAPOR PRO® COMMUNICATIONS to use “en-US” formatting
when converting text dates and numbers into appropriate data types, instead of the
local language settings, to prevent data conversion errors.

e Made the text boxes on the Options window editable.

V1.0.1:
e Added support for the VAPOR PRO®’s new TIME then RATE ending criteria.

e Added the Data Conversion Utility to convert memory starts to the new format.
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TRADEMARK AND COPYRIGHT PROTECTION

The copyright and intellectual property rights of this software, VAPOR PRO®
COMMUNICATIONS Package, and all its documentation, are owned by Arizona
Instrument LLC, and are protected by copyright laws and international intellectual
property rights treaties. You may not copy any portion of the software or documentation
in any form, except to use this software in accordance with the terms of the agreement or
to make one copy for backup purposes. You may not alter the software in any way. If
copies of the documentation must be made, you should make them in printed form only.

VAPOR PRO, Arizona Instrument, AZI and the stylized AZI are all registered
trademarks of Arizona Instrument LLC.

Instrument firmware is copyright protected.
All specifications subject to change without notice.

Copyright 2003-2010, Arizona Instrument LLC. All Rights Reserved.

Arizona Instrument LLC

VAPOR PRO® COMMUNICATIONS Operation Manual
Part Number 700-0098-C

September 2010

Windows®, Office® and Excel® are registered trademarks of Microsoft Corporation in the
United States and other countries.

If you have any questions regarding the operation of this software, please call our toll free
number (800) 528-7411. Internationally, call (602) 470-1414 or fax (480) 804-0656.
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